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Chapter 1:   Getting Started

Welcome

Exposure is a Photoshop-compatible plug-in that makes digital images look 
like they were shot on film. With Exposure, you can imitate the look of a film 
stock, such as Velvia, apply special effects like selenium/sepia toning, or do 
some basic image enhancement.

Exposure takes the form of two entries in the Photoshop Filter menu, one for 
color film and one for black and white film. The Color Film filter works on RGB 
images. The Black and White Film filter can be used on RGB images or 
Grayscale images. Both filters work with 8, 16, or 32 bits/channel images. 
Both filters can be used in Photoshop actions, making it easy to apply them to 
batches of images.

How to Use This Manual

The Installation chapter provides information on installing and registering 
Exposure, as well as host and system requirements.

The User Interface chapter details how to preview effects, apply them, and 
work with settings. To get the most out of Exposure, be sure to read this 
chapter. We have a lot of cool features that may not be obvious. 

The Factory Settings chapter describes the settings that come with Exposure. It 
gives background on how they were created and advice on when to use them.

The remaining chapters are devoted to tabs in the user interface. The Color 
tabs of the Color Film and Black and White Film filters are different. So two 
chapters are dedicated the Color tab, one per filter.

The chapter on the Tone tab describes our curve editor. Be sure to read about 
our improvements that make it different from Photoshop’s curve editor. We 
added some sliders to simplify common curve adjustments.
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The chapter on the Focus tab describes the sharpening and softening controls. 
Our color sharpening controls include a checkbox that reduces some of the 
ugly artifacts of unsharp masking. Our softening controls include an opacity 
slider that allows classic, glamour shots effects.

The chapter on the Grain tab describes our sophisticated grain generator. Our 
grain capabilities reach far beyond the simple pixel-sized noise found in 
image editors.
2



Chapter 2:   Installation

Installing Exposure is pretty quick and painless, but to be safe, follow these 
instructions.

Host Requirements

Exposure is a plug-in. That means that you must already have installed one of 
the following host programs. It is possible that Exposure will work with other 
image editors, but we have only tested with and support the ones below.

• Adobe Photoshop CS or later
• Adobe Photoshop Elements 3 or later
• Macromedia Fireworks MX 2004 or later
• Corel Paint Shop Pro 9 or later

System Requirements

Macintosh Systems
• 1 GHz PowerPC G4 processor
• 256 MB RAM
• Mac OS X 10.3.8 or later

Windows Systems
• 2 GHz Pentium 4 or later processor
• 256 MB RAM
• Windows 2000 or Windows XP

Macintosh Installation
Use the following instructions to install Exposure:

1. Shut down your graphics host program.

Note: To install Exposure, your OS X user account must have 
administrator privileges. For information on configuring your user 
3



account for administrator privileges, talk to your IT guy or consult your 
OS X user manual.

2. Insert the Exposure CD into your computer. If you purchased an electronic 
version of Exposure, locate the Exposure installation program that you 
downloaded from the online store. 

3. Double-click the Exposure icon.

4. Click Continue. 

5. Read the License Agreement.

6. Click Accept.

7. Enter your name, company name (optional) and your registration code.

Note: The registration code is a 12-letter sequence inside the front cover 
of your manual. 

If you purchased an electronic version of Exposure, you’ll find the 12-
letter code in the e-mail invoice, sent with your downloaded software. 
Store this e-mail in a safe place for future installations.

8. Click Register.

Our installer will search for all compatible graphics programs on your 
computer and display them in a list. 

9. Highlight one program (you can only install into one graphics program at 
a time) and click OK.

Rerun the installer if you wish to install Exposure into other graphics 
programs.

Windows Installation
Use the following instructions to install Exposure:

1. Shut down your graphics host program.

Note: To install Exposure, your Windows 2000 or XP user account must 
have administrator privileges. For information on configuring your user 
account for administrator privileges, talk to your IT gal or consult your 
user manual. 
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2. Insert the Exposure CD into your computer. If you purchased an electronic 
version of Exposure, locate the installation program that you downloaded 
from the online store. 

3. Double-click the Setup.exe icon.

4. Click Next. 

5. Read the License Agreement.

6. Click Accept.

7. Enter your name, company name (optional) and your registration code.

Note: The registration code is a 12-letter sequence inside the front cover 
of your manual. 

If you purchased an electronic version of Exposure, you’ll find the 12-
letter code in the e-mail invoice, sent with your downloaded software. 
Store this e-mail in a safe place for future installations.

8. Click Next. 

Our installer will search for all compatible graphics programs on your 
computer and display them in a list.

9. Highlight one program (you can only install into one graphics program at 
a time) and click OK. 

Rerun the installer if you wish to install Exposure into other graphics hosts. 

Registering Exposure
You must register your software to receive technical support and critical 
product updates. Registration also qualifies you for product discounts and 
upgrade pricing on future versions of Exposure.

If you purchased Exposure directly from Alien Skin Software, you are 
automatically registered with us. You need to register only if you purchased 
Exposure elsewhere. 

You can register online at http://www.alienskin.com/register. If you don’t have 
access to the World Wide Web, mail in the registration card included with your 
software.
5
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Chapter 3:   User Interface

This section outlines the menus, buttons, settings, and other items in the 
Exposure user interface. 

Navigation

Menus

Command menus are accessible when you launch any filter. Macintosh users 
will see the menus in place of their usual menu bar. Windows users will see the 
menus at the top of the filter preview window.

Edit Menu

The Edit menu provides an unlimited number of undos and redos. If you 
experiment with the sliders and find that you prefer a previous group of 
settings, select the Undo command from the Edit menu, or click Command+Z 
(Control+Z on Windows machines) to back up as many times as necessary.

The Edit menu also lets you copy, cut, paste and delete values from parameter 
fields.

Filter Menu

The Filter menu lets you switch between Exposure filters without leaving the 
user interface. Photoshop users should note that switching filters will make the 
Actions, History, and Last Filter Used functions behave oddly. These will record the 
filter initially selected, not the filter applied.

View Menu

The View menu lets you zoom the preview in and out. To display the preview at 
100% magnification, select Actual Pixels. See Keyboard Shortcuts for some nifty 
zooming shortcuts.
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Help Menu

The Help menu leads to local documentation and online Web pages. Clicking 
Help>Filter Help accesses filter-specific documentation. The same assistance 
can be reached by pressing F1 (Windows) or Help (Macintosh).

To access a Table of Contents for the online Help file, click Help>Contents.

Common Tools

To limit redundancy in the filter chapters, we’ve adopted the policy of 
documenting common tools in one section of the manual. Conveniently, you 
have arrived at this magical place. Here you’ll find explanations for how to 
use the Color Picker, and the Color Cube.

Color Selection Tools

Color Picker

Using the Color Picker, you can select colors based on several color models 
(RGB, CMYK, etc.). You can also specify colors by hexadecimal values or use 
Web safe colors. To launch the Color Picker, click the color swatch next to any 
color control.

If you don’t know how to use a color picker, consult your host program’s 
documentation.
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Color Cube

To the right of the color swatch, you’ll notice a color selection tool, which 
offers the following options.

Eyedropper: Select the eyedropper to sample a color from anywhere in the 
preview window.

Foreground or Background Color: Choose either of the two.

Black or White: Choose either of these timeless colors.

Six Previous Colors: You can choose any of the six most recently chosen colors.
9



The Preview Window

Tabs (A): Tabs with sliders, color swatches, check boxes, and radio buttons 
appear along the left side of the window. These controls perform most 
functions in our filters. Click on a tab name to switch to that subset of controls. 
Refer to the filter chapters for detailed control descriptions.

Thumbnail Navigation (B): Click and drag the movable red box to move the 
preview to any spot in the selected layer.

Move, Zoom and Show Original (C): The Move (hand), Zoom (magnifying glass) and 
Show Original buttons are found above the preview window. 

Click the hand to enable the Move tool, then click and drag to move around 
the preview image.

Click the magnifying glass to enable the Zoom tool. Click in the preview 
window to zoom into your image. Command + click to zoom out (Alt + click 
for Windows users). Double-clicking the magnifying glass at any time resets 
the preview window to 100% magnification.
10



The Show Original button toggles the preview between filtered and unfiltered 
versions of your image. Click and hold the button to view the unaffected 
image. Release the button to preview the effect.

UpToDate Message Indicator (D): When you see this visual cue, you have a new 
message from Alien Skin Software. See the UpToDate Messages section for 
more details.

Split Screen Preview (E): Above the preview area is a menu of options for split 
screen previewing. When enabled, this feature shows the original image in 
half of the preview. The entries in the Split Screen menu specify the orientation 
of the split line or simply turn it off.

OK and Cancel Buttons (F): Clicking the OK button applies the filter with the current 
settings. Clicking Cancel closes the filter window without applying the effect.

Mouseover Help String Area (G): Elements in each filter have mouseover help text. 
Whenever you move your cursor over a user interface element, a short 
description appears in the bottom left corner of the window.

Preview Window Area (H): Preview the effect on your image here. Clicking and 
dragging any corner or edge of the filter window resizes the preview area.

Progress Bar (I): The rectangle to the left of the magnification indicator displays 
the percentage of rendering completed.

Magnification Indicator (J): The current level of magnification is shown to the right 
of the render status bar at the lower right corner of the filter window.

Maintaining Settings

The Settings tab in each filter window lets you create, manage, download, 
share and back up your favorite filter recipes.

To apply a setting, click the Settings tab and select the desired setting in the list.
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Saving Settings

To save a setting:

1. Adjust sliders to taste. 

2. Click the Settings tab. 

3. Click Save. 

4. Type a name for your new setting into the Save Setting window. 

5. Click OK. 

You can also save a setting by pressing Command + S (Macintosh) or Control 
+ S (Windows) any time while previewing an effect. The Save Setting dialog box 
will appear.

Renaming Settings

To rename a setting:

1. Click the Settings Tab. 

2. Click Manage. 
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3. Select the setting that you want to rename. 

4. Click Rename. 

5. Type in the new name. 

6. Close the Manage Settings dialog. 

Deleting Settings

To delete a setting: 

1. Click Manage. 

2. Select the setting you want to delete. 

3. Click Delete. 

4. Click Yes to confirm the deletion. 

Exporting Settings

When you export a setting, Exposure packages the recipe in a tiny file that you 
can share with friends. You can also use the export feature to back up settings 
that you cannot live without.

To export a setting:

1. Click Manage. 
13



2. Select the setting you want to export. 

3. Click Export. 

4. Navigate to the location where you want to store the settings file. 

5. Click OK. 

Importing Settings

There are two ways to route settings to Exposure. The first method is the 
simplest way to import shared or archived settings: 

1. Find the setting that you want to add. 

2. Double-click it. 

3. Click OK. 

If you prefer doing things the hard way, use the following method:

1. From within the user interface, click the Settings tab. 

2. Click Manage. 
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3. Click Import. 

4. Navigate to the location where you have stored the setting. 

5. Click Open. 

6. Close the Manage Settings dialog. 

E-mailing Settings

To e-mail a setting:

1. Click Manage. 

2. Select the setting you want to e-mail. 

3. Click E-Mail. 

If your e-mail client is compatible with our settings manager, a message will 
pop up like magic, with the setting attached. Eudora, Outlook, Microsoft 
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Entourage (Mac), Apple Mail and Outlook. Express work great. Netscape 
Mail is not compatible with our e-mail feature.

Create Output in a New Layer above Current

Applying a filter with this option enabled renders your image in a new layer 
above the working layer (in Photoshop and Elements only). This checkbox is 
located on the Color tab for both the Color Film and Black and White Film filters.

Note that switching filters within Exposure disables the output in new layer 
feature. If you want to apply a filter in a new layer, make sure you start with the 
filter you plan to apply.

Also, Create Output In New Layer Above Current is unavailable when recording 
actions in Photoshop. Clear this checkbox when recording actions.

Overall Intensity

This slider appears below the New Layer checkbox. Any value less than 100 
reduces the effect of the filter. This feature essentially mixes the filtered image 
with the original image. Overall Intensity provides an easy way to tone down an 
effect without having to touch a bunch of sliders. Be warned, however, that if 
Overall Intensity is left at a low value, you may wonder why Exposure isn't doing 
much to your images. We recommend you leave this slider at 100% most of 
the time.

UpToDate System

The UpToDate messaging system informs you about the latest Alien Skin 
Software products, special offers, software updates and other news. 

When enabled, an unobtrusive visual cue announces, "Click here for new 
messages from Alien Skin Software." Click this link to read your new 
messages. See the interface example below:
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Customizing UpToDate Preferences

Receiving messages is optional. You can specify the intervals at which your 
UpToDate system checks for messages. To customize your UpToDate message 
preferences, use the following instructions:

1. In any filter, Click Edit>Preferences.

2. Select the frequency at which you would like the UpToDate system to 
check for new messages. If you don’t want to receive messages, select 
Never.

Windows users: If you have a dial-up Internet connection, you should select the 
Ask me before making an Internet connection option. If not, your computer will 
make unexpected phone calls.

Macintosh users: If you have a dial-up Internet connection, deselect the Ask me 
before making an Internet connection option. You must establish an Internet 
connection before receiving UpToDate messages.

Resetting Settings to Factory Default

Every filter has a Factory Default setting. Clicking this setting resets the current 
filter parameters. You can also press the F5 key (Windows) or Command + R 
(Macintosh) to reset the filter. 

That’s it for the opening section. We’ve designed this software to be both fun 
and easy to use. We hope you enjoy using the filters.
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Keyboard Shortcuts

Shortcut Function Macintosh Windows

Next Editable Text Field Tab Tab

Previous Editable Text Field Shift+Tab Shift+Tab

OK Return Return

Cancel Escape Escape

Undo Command+Z Control+Z

Redo Command+Y Control+Y

Cut Command+X Control+X

Copy Command+C Control+C

Paste Command+V Control+V

Next Filter Command+] Control+]

Previous Filter Command+[ Control+[

Zoom In Command++ Control ++

Zoom Out Command +- Control + -

Actual Pixels Option+Command+Zero Alt+Control+Zero

Restore Default Settings Command+R F5

Load Last Used Settings Command+L Control+L

Save Setting Command+S Control+S

Switch to Move Tool (hand) H H

Switch to Zoom Tool Z Z

Zoom In (with zoom enabled) Mouse Click Left Mouse Click

Zoom Out Option + Mouse Click Alt + Mouse Click

Zoom to Actual Pixels Double-click Zoom Tool Double-click Zoom Tool

Increase/Decrease Slider by 1 Up/Down Arrow Up/Down Arrow

Increase/Decrease Slider by 10 Shift+Up/Down Arrow Shift+Up/Down Arrow

Access Online Help Command+/ OR Help F1
18



Chapter 4:   Factory Settings

Settings can be found in the far left tab in the user interface. The factory 
settings are in the top area. The settings you have created are in the bottom 
area.

Film Settings

The most important settings are named after film stocks and begin with the 
word “Film.” Selecting one of these settings sets many parameters throughout 
the tabs. Each of these settings encompasses many effects that add up to a 
certain look.

To imitate film stocks that were available during creation of Exposure, we did 
test shoots with the film and with a Canon 20D digital camera. We shot a 
special chart, as well as scenes including flesh tones and colorful natural 
objects. We then measured differences between the film and digital images 
using custom software we created. This enabled us to create settings that 
mimic the look of these film stocks. Most of the film settings control warming/
cooling (or sometimes filter color), saturation (for color films), RGB sensitivity 
(for black and white films), a curve in the Tone tab, and grain parameters. We 
chose to leave black and white colorization and focus controls untouched in 
the film settings. Those controls are more for special effects.

For film stocks that were discontinued years go, like GAF 500 and Kodak EES, 
we obtained archival photos and experimented until our settings closely 
matched the images. For these settings, we owe Greg Myhra and Larry 
Ketchum a debt of gratitude. 

We are glad those guys never throw anything away! If you would like us to 
generate settings for any film stocks that are not in our list, please show us 
some high-resolution examples, and we will give it a shot.
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Compared to digital sensors, film has a less linear response to light. Below is 
a characteristic curve for a film stock.

If this curve were a straight line, the response would be perfectly linear, and 
the film would reproduce a perfectly realistic image within that brightness 
range. Whenever the curve is shallower than 45°, contrast is lowered. Areas 
steeper than 45° designate increased contrast. This S-shaped curve would 
increase contrast in midtones, block up shadows, and blow out highlights. 
Expect to see varying amounts of these effects from all of the settings based on 
real film stocks. If these effects bother you, simply reset the curve in the Tone 
tab after loading the settings.

The Grain tab is the most unique part of Exposure. We put film grain under a 
microscope, literally. There we found that real grain can be larger than one 
pixel, has subtle color characteristics, and often appears with different 
strengths in the highlights, midtones, and shadows. Below are some examples 
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of our microscope photos. As you might expect, the higher speed film has 
larger grains.

Above are photomicrographs that we took whiles studying film grain. From left to right they 
are Kodak TRI-X 400, Fuji Velvia 100, and Ilford Delta 3200.

Note that the film settings are designed to be applied to images that have 
received very little manipulation. If these are applied to an image that has 
boosted color and/or contrast, the result will appear quite extreme. 

Image Enhancement Settings

If you want to use Exposure for specific image enhancement tasks rather than 
full-blown film simulation, then look for the settings that begin with “Modify.” 
These settings usually control a subset of parameters, making them much 
easier to understand than the film settings.

Special Effect Settings

These settings are for creative work rather than accurate simulation of film 
stocks. Their names begin with “Special.” This category encompasses a wide 
range of effects such as cross processing, selenium/sepia toning, and 
glamour shots soft focus.
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Chapter 5:   Color Film - Color Tab

This chapter describes the Color tab of the Color Film filter. This tab controls 
color casts and saturation. The Color tab of the Black and White Film filter is very 
different. Therefore, we cover it in the next chapter.

The Color tab for the Color Film filter.

Filter Color and Filter Density

Use these controls to simulate adding a colored filter to the lens of the 
camera. This alters the hue of the scene. The farther the Filter Color is from 
white the stronger the effect will be. Increasing Filter Density also increases the 
filtering effect. Use these controls for odd color casts. If you simply want to 
warm or cool the scene then use the slider below.
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Warming/Cooling

Changing the light temperature of a scene is the most commonly needed type 
of color filtering. Warm scenes appear more yellow, cool scenes more blue. 
Move this slider to the right to warm the photo or to the left to cool it. 

The top third of this photo has been cooled. The bottom third has been warmed.

Preserve Luminosity

Enable this option to ensure sure that the filtering operations do not darken 
your photo. When this option is off, color filtering is more physically accurate. 
Preserve Luminosity affects both the Filter Color and Warming/Cooling features.
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Saturation Controls

The Master Saturation slider simply increases or decreases the intensity of all 
colors in the photo. The Red, Green, and Blue sliders modify subsets of color.

The most common use of these controls is increasing saturation in nature 
scenes. However, you can also desaturate two colors to make an object of the 
third color stand out. 

In the right half of this photo, blue and green were reduced, making the red car stand out.
25
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Chapter 6:   Black and White Film - Color Tab

This chapter describes the Color tab of the Black and White Film filter. This tab 
controls the conversion of color images to black and white, as well as 
colorization. The Color tab of the Color Film filter is described in the previous 
chapter.

The Color tab for the Black and White Film filter.

Color Conversion - Red, Green, Blue

The Red, Green, and Blue sliders control how much each color channel affects 
the final black and white photo. In a portrait, the blue channel can be 
downplayed to de-emphasize wrinkles and blemishes. You can use these 
sliders to simulate a color filter over the lens of the camera. For instance, a 
deep red filter will make skies darker, as in the example. If your photo is in 
Grayscale mode then these controls will be disabled.
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Here setting the RGB values to 100/0/0 simulates a red filter. Note the darkened sky and 
brightened car body.

These sliders also go down to -100%. While this is not physically realistic, it 
can be used to increase contrast. When simulating infrared film, a negative 
value for Blue will make the sky very dark.

Equalize Channels

When this option is enabled, the Red, Green, and Blue sliders add up to 100%. 
This is useful for ensuring that your photo is roughly the same brightness as 
your original.

Colorization - Ink Color, Strength, Position

The ink controls at the bottom of this tab are for creative effects like sepia or 
selenium toning. For each ink, you can set its color, how much the ink shows 
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up, and where it appears in the brightness range of your photo. Think of the 
Ink Position slider as a gradient from shadows on the left to highlights on the 
right. Ink colors appear much stronger when placed in the shadows versus the 
highlights.

The top photo simulates selenium toning, the bottom sepia toning.
29
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Chapter 7:   Tone Tab

Both the Color Film and Black and White Film filters have a Tone tab. The Tone tab 
includes a curve editor along with some sliders we added to make common 
tasks quick and easy. Use the Tone tab to address issues like contrast, 
brightness, shadows, and highlights.

The Tone tab for Color Film filter.

Curve Editor

The curve editor displays how input brightness is converted to output 
brightness. The horizontal axis represents input brightness, and the vertical 
axis represents output brightness. By default, black is in the bottom left corner 
and white in the upper right corner. If you prefer to think in terms of density 
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rather than brightness, you may want to flip the curve. To do that, click 
anywhere in the gradients on the left or bottom of the curve.

Channel Pop-Up Menu

The Color Film curve editor has separate curves for the red, green, blue, and 
RGB channels. Changes made to the curve editor or the sliders below it affect 
only the selected channel. The RGB curve affects all channels and is applied 
after the individual channel curves. Switch between these curves using the 
Channel pop-up menu at the top of the Tone tab.

The Black and White Film curve editor has just a single gray curve and does not 
include a pop-up menu.

Editing Control Points

Changing contrast, brightness, shadows, and highlights involves adding, 
moving, and removing control points in the curve editor. To add a control 
point to the curve, click anywhere there isn’t already a point. To move a 
control point, simply click on it and drag it while the mouse button is down. To 
be more precise, select a control point by clicking on it and then edit the 
numbers in the Input and Output text boxes. To delete a control point, drag it 
out of the curve area. You can also or select it and then click on the Delete 
button.

Black/White/Gray Points

Use the three eyedropper buttons to easily set the black, white, and gray 
points of your photo. These can quickly expand the dynamic range of your 
photo or remove a color cast. After you click one of these buttons, the cursor 
becomes an eyedropper. Click anywhere in the preview to select a color. Note 
that the color selected will come from the original photo, not from the filtered 
version.
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Black Point

To select the black point, click on the leftmost of the three eyedropper buttons 
and then click on the blackest part of your image in the preview. This will set 
the leftmost control point in the individual Red, Green, and Blue curves. The 
point you selected will become pure black after filtering.

White Point

To select the white point, click on the rightmost of the three eyedropper 
buttons and then click on the whitest part of your image in the preview. This 
will set the rightmost control point in the individual Red, Green, and Blue 
curves. The point you selected will become pure white after filtering.

Gray Point

The gray point eyedropper tool is designed to help remove a color cast and is 
only enabled in the Color Film filter. To select a gray point, click on the middle 
eyedropper button and then click on a pixel of your image that should be any 
shade of neutral gray. This will set a middle control point in the individual Red, 
Green, and Blue curves. The point you selected will become neutral gray and 
any color cast it had will be removed. All other non-white and non-black 
pixels in the image are adjusted accordingly.
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In the top of this photo, a color cast was removed using the gray point tool.

The Sliders

Many people are scared of the curve editor found in Photoshop. Therefore, 
we provide four sliders that perform the most commonly needed curve 
transformations. When you move one of these sliders, a blue transformed 
copy of the curve is displayed in the curve editor. This blue curve is the one 
that affects your photo.

Contrast

Increasing this slider brightens highlights and darkens shadows. Increasing 
contrast will usually make a photo more dramatic at the expense of detail in 
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highlights and shadows. In some cases, you may be able to recover detail in 
photos that have harsh shadows or highlights by decreasing contrast.

Shadow

This slider brightens or darkens only the shadows. If your shadows are blocked 
up, you might be able to recover some detail by increasing this slider.

Midtone

This slider brightens or darkens the image, having its strongest effect in the 
midtones. The result is similar to gamma correction, but is not quite as harsh.

Highlight

This slider brightens or darkens only the highlights. If your highlights are blown 
out, you might be able to recover some detail by decreasing this slider.

The Buttons

Editing curves can be a lot of work, and a complicated curve is tedious to 
reproduce. So we thought you might want an easy way to save and load 
curves. In addition, we have provided a way to reset the parameters of the 
Tone tab.

Save

The Save button brings up a standard file saving window that lets you save 
your curve to a file. For the Color Film filter, the curves for all of the channels 
are saved together in one file.

Load

The Load button brings up a standard file loading window that lets you replace 
your curve with one from a file. For the Color Film filter, the curves for all of the 
channels are loaded together.
35



Reset

To reset all the controls in the Tone tab to their default positions, press the Reset 
button. This will result in a curve that does not alter the photo. Note that in the 
Color Film filter, the Reset button resets the curves for all of the channels.
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Chapter 8:   Focus Tab

The Focus tab contains controls for sharpening and blurring.

The Focus tab for the Color Film filter. The Sharpen Brightness Only checkbox is only present 
in the Color Film filter.

Sharpening

First a word of warning about sharpening. Oversharpening quickly makes a 
photo look artificial. As a general rule, we suggest that you reduce sharpening 
until it is not immediately apparent that the photo was sharpened. When your 
photo will be printed by a process that causes blurring, you may need to 
sharpen to a point that looks strong on the screen but will look appropriate in 
print.

Sharpen Amount

This slider controls the overall strength of the sharpening. Typical usage is a 
value less than 30. Generally a larger Sharpen Radius will require an even lower 
value for Sharpen Amount.

Sharpen Radius

This value determines the size of features that are most affected by 
sharpening. Typical usage is very small, such as 0.5 to 1.5 pixels. Extremely 
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blurry and/or higher resolution photos may require a larger radius. The best 
effect results from using the smallest radius that still sharpens your image.

Sharpen Threshold

This control restricts the sharpening to areas with strong edges. Increasing this 
slider leaves smoother areas unaffected. Most people find this control a little 
esoteric. If you like your tools simple, then just leave this at zero, and you’ll be 
fine.

Sharpen Brightness Only

When this option is enabled, only the brightness of a color photo is 
sharpened. The hue is unaffected. This reduces obvious color halos and other 
artifacts. To be honest, we haven’t found a situation where we would turn this 
off. This feature is present only in the Color Film filter.

The right half of this shot was sharpened with Sharpen Brightness Only enabled. Note the 
greatly reduced artifacts.
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Blurring

Why would anyone want a blurry photo? A very slight blur can reduce the 
harshness of a digital photo or reduce the effects of oversharpening. Most of 
the time, however, a simple Gaussian Blur adds little to a photo. If that blur is 
very transparent, the result is that familiar, hazy glow found in glamour 
portraits. This effect is great for making wrinkles and blemishes less obvious.

The left half of this image was blurred to reduce the appearance of wrinkles.

Blur Opacity

For a very subtle effect, try values less than 20%. Your subject may not realize 
that you softened the photo. For an obvious effect, like the photos made at the 
mall, crank Blur Opacity up to 70%.
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A more subtle blur gives the right half of this image an artistic look.

Blur Radius

Like Blur Opacity, increasing the reach of the blur will make your effect more 
obvious. A very high radius will make a photo hazy and lower contrast.
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Chapter 9:   Grain Tab

The Grain tab adds realistic grain to selected tonal ranges of your photo.

The Grain tab for the Color Film filter. The Color Variation slider is only present in the Color 
Film filter.

Background

Real film grain is nothing like the noise feature in today’s image editors. Real 
grain appears selectively in different tonal ranges, is not square like a pixel, 
and has subtle color variation. We studied grain in archival photos, did test 
shoots, and used microscopes to examine the structure of film grain. With that 
knowledge we created a grain generator that is sophisticated and very 
realistic.

Below are some photomicrographs of some of the films we examined. Notice 
the irregular shape and random spacing of the grains. You would never blow 
up an image enough to see this level of detail, but these variations cause the 
effect we call grain.
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Kodak TRI-X is on the left. Ilford Delt2 3200 is on the right. The graininess of the high-speed 
film is very apparent.

Below, a photomicrograph of Fuji Velvia 100 shows why modern color slide 
films have very little grain. Ignore the bubbles. Those are part of a protective 
layer above the pigment. During development the silver grains were replaced 
by clouds of pigment. These clouds do not have a sharp edge like the grains 
in the black and white examples. The result is much less noticeable grain. 
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In Fuji Velvia 100, the edges of the grain are barely apparent. This is why modern slide films 
have very little grain.
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Tonal Ranges - Shadow, Midtone, Highlight

The Shadow, Midtone, and Highlight sliders add grain selectively to the tonal 
ranges of a photo. Film tends to have more grain in midtones than in shadows 
and highlights.

Grain appears only in the midtones of the left half of this image, but in all the tonal ranges of 
the right.

Grain Size

Increasing grain size beyond one pixel creates non-square grain. Typical 
usage is usually less than 3 pixels, especially for a subtle effect. Simulating 
high-speed film and/or working with a very high resolution photo, however, 
may dictate larger grain. If you are trying to simulate very large grain, we 
suggest applying a blur. In huge photo enlargements, details smaller than the 
grain size are not visible. For a grain size of 4 pixels, a blur of 2 pixels at 
100% opacity should do the trick.
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Color Variation

This slider controls the amount of color variation the grain causes. We found 
that real grain is quite colorful, but you may want to tone it down for aesthetic 
reasons. This slider is only present in the Color Film filter.
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Chapter 10:   For More Information...

The more we learn about photography, the more we realize that there is more 
to learn! The following books helped us immensely in the creation of this 
software. If you are a photography geek, these books should go on your wish 
list.

The Manual of Photography, Ninth Edition (2003), by Ralph Jacobson, Sidney Ray, 
Geoffrey Attridge, and Norman Axford, Focal Press, first published 1890

If you really want to learn the science of photography, it doesn’t get better than 
this book. The discussion of characteristic curves was valuable in 
understanding what to expect from our measurements of real film. Be 
forewarned, this book is full of math and chemistry and has nothing to do with 
creative topics.

The Photographer’s Toning Book, Tim Rudman, Amphoto Books, 2002

This book inspired us to enhance our colorization feature. When we saw that 
we couldn’t do some of the beautiful effects in this book, we beefed it up. The 
test strips in this book really helped a lot in developing this feature.

Light and Film, Life Library of Photography, Time Life Books, 1970

Yeah, we thought that Time Life books were lame, too, until we saw this one. 
The gem in this book is Chapter 2, The Evolution of Film. There you can learn 
about the laborious early methods of photography. You even get to see a 
modern (well, 1970) guy use these methods and see what kind of results he 
gets.
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